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Elõszó 

Kedves S7-200 felhasználó! 
Amennyiben Ön készít egy vezérlõ programot, amellyel automatizálási feladatokat szeretne 
megoldani, az egy ún. Programozható Logikai Vezérlõn fut le. Az S7-200 Mikrovezérlõ segíthet
Önnek megoldani az automatizálási problémákat, mialatt a biztonság, a minõség, 
a termelési sebesség növekszik és a projekt-költség csökken. 

Az S7-200 Mikrovezérlõt egyre több helyen használják, mert a robosztus külsõ vonzó árral 
és egyszerû mûködéssel párosul. 

Annak érdekében, hogy Ön a lehetõ legegyszerûbben tegye meg az elsõ lépést az S7-200 PLC felé 
mi létrehoztunk egy speciális induló-készletet (Starter Kit). 

Ez az 1 órás tanfolyam megtanítja Önt az alapképességekre, hogy képes legyen 
a lehetõ legrövidebb idõn belül használni az S7-200-as PLC-t.
És most egyszerû, gyors kezdést és sok sikert kívánunk Önnek! 

bereca
Beírt szöveg
Sok szerencsét!

bereca
Beírt szöveg



                                                        

Elõszó 
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Az S7-200 induló készlet tartalma 

Eszköz Mennyiség  Elérhetõ 

S7-200 CPU 222 AC/DC/RLY 1 
Bemeneti szimulátor CPU 222 - höz 1 
Szoftver: STEP 7-Micro/WIN V4  1 
Kimeneti szimulátor egy szerelõsinen  1 
PC/PPI Programozó Kábel (USB/RS 485)  1 
S7-200 Dokumentáció  1 
Egy Órás Tanfolyam (tartalmaz egy CD-t példaprogramokkal) 1 
Csavarhúzó 1 

Gyakorlati példákat talál az 1 órás tanfolyamhoz a STEP 7-Micro/WIN 
dokumentációs CD-n a következõs helyen: \English\Manuals\PrimerEx. 

Biztonsági irányelvek 
Az 1 órás tanfolyam az S7-200 gyors bemutatására szolgál. Nem helyettesíti az S7-200 
Rendszer Gépkönyvet (System Manual).  Ezért Önnek be kell tartania az S7-200 
rendszer gépkönyvben található utasításokat, különösen a biztonsági irányelveket. 
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1Hardver installálása 

1.1  Hardver összeszerelése és üzembehelyezése 

Hardver összeszerelése és üzembehelyezése 
1. Rögzítse a mellékelt szerelõ sínt az alaplemezre az ábrán látható módon. 

Alap lemez 

2. Rögzítse a mellékelt bemeneti szimulátort a bemeneti sorkapocshoz, ami az S7-200 
alján található. 

S7-200
CPU 222��

3. Rögzítse az összeszerelt S7-200-at a szerelõ sínre. 

4. Rögzítse a kimeneti szimulátort a szerelõ sínre. 
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bereca
Beírt szöveg

bereca
Beírt szöveg

bereca
Beírt szöveg

bereca
Beírt szöveg
Kimeneti szimulátor

bereca
Beírt szöveg
Bemeneti szimulátor

bereca
Beírt szöveg

hidasg
Beírt szöveg
Szerelő sín
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1.2  S7-200 (CPU 222) részletezése 

�

bereca
Beírt szöveg
Kimeneti
terminál

bereca
Beírt szöveg
Tápegység

bereca
Beírt szöveg
Üzemmód kapcsoló
STOP, TERM, RUN

bereca
Beírt szöveg
Csatlakozó
bővítő modulokhoz

bereca
Beírt szöveg
Analóg 
potenciométer

bereca
Beírt szöveg
             RS 485
Kommunikációs Port

bereca
Beírt szöveg
Bemeneti
Sorkapocs

bereca
Beírt szöveg
24 VDC Érzékelő Táp
             (180 mA)

bereca
Beírt szöveg
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1.3  Az összeszerelt hardver vezetékezési ábrája 

Az összeszerelt hardver vezetékezési ábrája 
Csatlakoztassa a vastagon jelölt kábeleket az ábra szerint. A szürke kábel csak mechanikusan 
van rögzítve a kimeneti szimulátorhoz. Tehát az egyik végét sem kell csatlakoztatni a táphoz. (L+; 1L) 

!

/�

0

�/

3(
1
/�

������ ��� 3( 1 /�

6�������&38�����
���(6�������%%����;%�

���� ��� ���

4���

�0 ��� �0 ��� ��� 0 /�

bereca
Beírt szöveg

bereca
Beírt szöveg
Kimeneti
Szimulátor

bereca
Beírt szöveg
Bemeneti szimulátor

bereca
Beírt szöveg
Föld (kék)

bereca
Beírt szöveg
Be/ki
(piros)

bereca
Beírt szöveg
Irányváltó
(fekete)

bereca
Beírt szöveg
Tápegység:
85 - 264 V AC / 47 - 63 Hz
Mindig csatlakoztassa a földelést!

bereca
Beírt szöveg
szürke

bereca
Beírt szöveg
Érzékelő táp

bereca
Beírt szöveg
szürke

bereca
Beírt szöveg
kék

bereca
Beírt szöveg

bereca
Beírt szöveg
Figyelem!
Anyagi kár vagy 
sérülés veszély.

bereca
Beírt szöveg

bereca
Beírt szöveg

hidasg
Beírt szöveg
jkkjk
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Az összeszerelt hardver áramköri ábrája 

bereca
Beírt szöveg
Tápegység:
85 - 264 V AC / 47 - 63 Hz
Mindig csatlakoztassa a földelést!

bereca
Beírt szöveg
A belső relék kontaktusai
relés kimenetek

bereca
Beírt szöveg
Érzékelő táp

bereca
Beírt szöveg
Bemeneti 
Szimulátor

bereca
Beírt szöveg

hidasg
Beírt szöveg
Kimeneti
Szimulátor

hidasg
Beírt szöveg

hidasg
Beírt szöveg
DC 24V

hidasg
Beírt szöveg

hidasg
Beírt szöveg
1L   Q0.0  0.1   0.2    0.3

hidasg
Beírt szöveg
      S7-200 CPU 222

hidasg
Beírt szöveg
6ES7212-1BB23-0XB0

hidasg
Beírt szöveg

hidasg
Beírt szöveg
L1

hidasg
Beírt szöveg
N

hidasg
Beírt szöveg
PE

hidasg
Beírt szöveg

hidasg
Beírt szöveg
24V bemenetek (bemeneti jelszint: 0-24VDC)

hidasg
Beírt szöveg

hidasg
Beírt szöveg
1M    I0.0    0.1     0.2   0.3    2M    0.4     0.5    0.6    0.7    M    L+

hidasg
Beírt szöveg
-            +

hidasg
Beírt szöveg
+

hidasg
Beírt szöveg
L+

hidasg
Beírt szöveg
M
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Az S7-200 CPU áramköri ábrája (CPU 222 AC/DC/RLY)) 

�
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bereca
Beírt szöveg
6 relé kimenet Q0.0 - Q0.5
24 V DC / 24 - 230 V AC max. 2A

bereca
Beírt szöveg
Tápegység
(85 - 264 V AC)

bereca
Beírt szöveg
Érzékelő tápegység
24 V DC / 180 mA
érzékelők vagy bővítő modulok számára

bereca
Beírt szöveg

hidasg
Beírt szöveg
Kimeneti oldal

hidasg
Beírt szöveg

hidasg
Beírt szöveg
1L   0.0  0.1  0.2                                              N   1L

hidasg
Beírt szöveg
1M  0.0  0.1  0.2  0.3  

hidasg
Beírt szöveg
2M  0.4  0.5

hidasg
Beírt szöveg
M   L+

hidasg
Beírt szöveg
Bemeneti oldal

hidasg
Beírt szöveg

hidasg
Beírt szöveg
8 bemenet I0.0 - I0.7 (24VDC)

hidasg
Beírt szöveg
CPU 222 AC/DC/RLY (AC Tápfeszültség/DC Bemenetek/Relé Kimenetek)

hidasg
Beírt szöveg
6ES7212-1BB23-0XB0

hidasg
Beírt szöveg
+

hidasg
Beírt szöveg
+
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Szoftver telepítése 

2.1  STEP 7-Micro/WIN telepítése az Egyórás Tanfolyamhoz 
A STEP 7-Micro/WIN V4 programozó szoftver telepítéséhez Önnek szüksége van egy PC-re, 
vagy egy programozó eszközre (PG) egy Microsoft Operációs rendszerrel. A szoftver
 Windows 2000 Service Pack 3, Windows XP Home, 
vagy Windows XP Professional alatt fut. 

1.  Helyezze be a CD-t a PC-be, vagy a PG-be, amin Microsoft Operációs rendszer fut. 
2. Válassza ki a telepítést. 
3. Indítsa el a Telepítõ Varázslót és kövesse az utasításokat.

                              Megjegyzés: Ha Önnek már telepítve van a STEP 7-Micro/WIN elõzõ verziója, kapni fog egy üzenetet, hogy
                              távolítsa el az elõzõ szoftvert és indísa újra a rendszert. Miután eltávolította az elõzõ szoftvert, indítsa újra

a telepítési folyamatot.
 Ha a telepítés befejezõdik egy  "STEP 7-Micro/WIN" bejegyzés fog megjelenni a Windows Start menüben.
Start menü, Start > SIMATIC. 

bereca
Beírt szöveg
1.

bereca
Beírt szöveg
2.

bereca
Beírt szöveg
3.
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2.2  STEP 7-Micro/WIN indítása 

A Windows Start menüben válassza a SIMATIC > STEP 7-Micro/WIN V4.0.x.xx > 
STEP 7-Micro/WIN hogy elinduljon a STEP7-Micro/WIN programozó szoftver. 
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2.3  A Súgó (Help) használata 
A Súgó Ablak, Tartalom, Index és teljes szövegben keresés segít Önnek megtalálni egy témát 
a Súgó témák ablakának indításával. 

Válassza ki a menü-t, vagy nyissa meg azt az eszközt, amirõl segítséget szeretne kapni, 
majd nyomja meg az F1 billentyût, hogy elérje a keresett eszközrõl az információt. 

Mi ez? (What's This?) segít Önnek a képernyõ elemek definícióiban. Ön szintén elérheti a Mi ez? 
Súgót a shift és az F1 billentyû egyidõben történõ megnyomásával. A mutató kérdõjelre vált, 
amivel aztán rákattinthat egy elemre, amirõl segítséget szeretne kapni. 

Ha az Ön számítógépe rendelkezik Internet hozzáféréssel, Ön letölthet információkat a 
SIMATIC S7-200 hardverérõl, vagy szoftverérõl, ha használja az "S7-200 on the Web" menü eszközt 
a Súgó menüben. 





3Alap beállítások 

3.1 A programozó kábel csatlakoztatása 

A PC/PPI Programozó kábel (USB/RS 485) összeköti a PC-t az S7-200 PLC-vel.

Használja a PC-jén lévõ szabványos USB csatlakozó aljzatot. Csatlakoztassa
az USB/PPI kábelt a PC-hez és a PLC-hez.

Kapcsolja rá a PLC-re a tápfeszültséget.

A STOP vagy a RUN LED-nek világítania kell.

S7-200 CPUPG/PC

USB port

One-Hour Primer 
Training Documents, 01/2007, A5E01031470-01 17 



Alap beállítások 
3.2 Az S7-200 kommunikáció beállítása 

3.2 Az S7-200 kommunikáció beállítása 
1. Klikkeljen a kommunikációs ikonra a navigációs sávban. 

2. Nézze át a kommunikációs beállításokat. 

3. Frissítéshez kattintson duplán a megfelelõ helyre. A csatlakoztatott CPU-t fel fogja ismerni 
és automatikusan egy listába rakja. 

4. Ha a CPU nem ismerhetõ fel, vagy egy felugró ablak azt "mondja", hogy a kommunikáció nem lehetséges, 
akkor kattintson duplán a PC/PPI kábel ikonra. 

5. Válassza ki a PC/PPI kábelt a PG/PC Felületen és válassza a Beállításokat. 

6. A PPI fülön állítsa az állomás-címet 0-ra és az átviteli rátát 9,6kbps-ra. A 
Local Connection fülön válassza ki az USB portot. Klikkeljen az OK_ra, hogy megerõsítse a beállításokat, 
majd zárja be a beállítások (Properties) ablakot. Kattintson az OK-ra ahhoz, hogy bezárja 
a "Set PG/PC interface-t, jegyezze meg, hogy az állomáscím nem egyezhet meg a CPU címmel! 

7. Dupla kattintás a megfelelõ helyre a kommunikációs mezõben a frissítéshez. A rendszer a CPU-t most már 
automatikusan felismeri és regisztrálja. A folyamat igénybe vehet néhány percet! 
Most kattintson az OK-ra és válassza a Kommunikációs párbeszéd ablakot. 

��
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3.3  Az elsõ mûködési teszt végrehajtása 
Ahhoz, hogy elvégezzük az elsõ mûködési tesztet, kövessük a következõ lépéseket: 

1. Állítsuk a PLC üzemmód kapcsolóját TERM vagy RUN pozícióba. Az üzemmód kapcsoló 
a CPU elõlapján, jobb oldalon a felnyitható fedél alatt található. 
Ne felejtse el, hogy a mûködési mód távvezérlése (RUN or STOP) csak akkor lehetséges, ha 
az üzemmód kapcsoló TERM vagy RUN pozícióban van. 

2.  Kapcsoljuk az S7-200 PLC-t STOP illetve RUN módba a PC-rõl. 
A zöld RUN LED a PLC-n futás közben, RUN üzemmódban világít. A sárga STOP LED a 
PLC-n STOP üzemmódban világít. Ha szeretné átváltani a PLC üzemmódját a PC-rõl, 
akkor a PC és PLC közötti kapcsolatot helyesen kell konfigurálni. 
Ha az üzemmódot nem lehet változtatni, ellenõrizze a kommunikációs kábelt a PC és a PLC között, 
és a kommunikációs beállításokat a STEP 7-Micro/WIN-ben. 

��

��
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bereca
Beírt szöveg
PC / PPI kábel
a PC felé

bereca
Beírt szöveg





4

Eloszor is, On megtanulja, hogyan
nyisson meg egy peldaprogramot a 
CD-rol. Azutan attoltjuk a PLC-re
a�67(3���0LFUR�:,1�
programozo szoftver segitsegevel.

$IWHU�WKDW��\RX�ZLOO�IDPLOLDUL]H
\RXUVHOI�ZLWK�WKH�IXQFWLRQ�RI�
WKH�SURJUDP�\RX�KDYH�
WUDQVIHUUHG�

:LWK�EDVLF�NQRZOHGJH�DERXW�.ORJLF�
RSHUDWLRQV.�\RX�ZLOO�EH�DEOH�WR�
DQDO\]H�WKH�HOHPHQWV�RI�H[HUFLVH�
SURJUDP���DQG�XQGHUVWDQG�WKH
VWDWHPHQWV�LQ�LW�

,Q�WKH�6HFWLRQ�.0RUH�([HUFLVHV.�\RX�ZLOO
OHDUQ�WKH�LPSRUWDQW�NQRZOHGJH�\RX
UHTXLUH�WR�ZULWH�\RXU�RZQ�SURJUDPV�E\
FKDQJLQJ�WKH�H[HUFLVH�SURJUDP�
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Elsõ programozási feladat 

4.1  Az Ön elsõ programjának megírása 

3URJUDPPLQJ([DPSOHV

bereca
Beírt szöveg
Ön gyorsan megtanulhatja, hogyan kell
az alapfunkciókat a PLC-be kis lépésekben programozni, 
a mellékelt CD-n talalhato példaprogramok segítségével.

bereca
Beírt szöveg

bereca
Beírt szöveg

bereca
Beírt szöveg
Először is megtanuljuk, hogyan
nyissunk meg egy példaprogramot a
CD-ről. Azután áttöltjük a PLC-re
a STEP 7-Micro/WIN
programozó szoftver segítségével.

bereca
Beírt szöveg
Azután megismerkedünk
a programnak a funkciójával,
amit áttöltöttünk a PLC-re.

bereca
Beírt szöveg
A logikai műveletek alapismeretének
segítségével Ön képes lesz megvizsgálni
a példaprogram elemeit és megérteni
a működését.

bereca
Beírt szöveg
A "Több feladat" részben, Ön megfogja
szerezni azt a tudást, ami ahhoz szükséges,
hogy saját programot írjon a példaprogram
változtatásával.

bereca
Beírt szöveg
Nagyszerű! Az első működési teszt sikeresen megtörtént.
A vezérlő működik, futásban van és a kommunikáció
a PLC irányába rendben van.
	De hogyan írjam meg a programot?

bereca
Beírt szöveg



4.2

Elsõ programozási feladat 
4.2  Az elsõ gyakorlat megnyitása 

Az elsõ gyakorlat megnyitása
�

3UR
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bereca
Beírt szöveg
1. Helyezze be a CD ROM-ba a példaprogramokat tartalmazó CD-t.
    Ez a CD a kézikönyv utolsó oldalán található egy tartóban.

bereca
Beírt szöveg
2. Az első példaprogram megnyitásához válassza: File > Megnyitás -t. A megnyíló ablakban
                                     keresse meg a CD ROM-ot és nyissa meg a STEP 7 Micro/WIN 
	                 projektet a megfelelő nyelven.  (Az angol: 1hr_pr_en.mwp)

bereca
Beírt szöveg

bereca
Beírt szöveg
A STEP 7-Micro/WIN betöltötte a
példaprogramot a PC memóriájába
és megjelenítette a program első sorait
a programszerkesztőben.

bereca
Beírt szöveg



Elsõ programozási feladat 
4.3 Az elsõ felhasználói program letöltése a CPU-ba 

4.3  Az elsõ felhasználói program letöltése a CPU-ba 

� 

A futás közbeni szerkesztés csak a CPU 224, CPU 224XP és CPU 226-on elérhetõ. 
A futás közbeni szerkesztés RUN módban engedi a programot szerkeszteni.

A program letöltése a következõ lépésekbõl áll:
Az üzemmód kapcsoló TERM vagy RUN állása mellett, klikkeljünk a Letöltés ikonra.
A program automatikusan lefordítódik. Ha nincs hiba a programban
egy figyelmeztetõ ablak jelenik meg hogy kapcsolja a PLC-t STOP módba. 

Kattintson az OK gombra, hogy a PLC STOP módba lépjen. A program ezután 
letöltõdik a PLC-be.
Ha a program sikeresen letöltõdött a PLC-be, egy üzenet jelenik meg,
hogy figyelmeztesse Önt, hogy kapcsolja a PLC-t újra RUN módba. Kattintson az IGEN gombra,
hogy a PLC újra futás (RUN) módba kerüljön.

A program szintén áttölthetõ a PLC-bõl a programozó eszközre (PC-re). 
Kattintson a Feltöltés ikonra, ahhoz, hogy áttöltõdjön a program a PLC-rõl 
a programozó eszközre, PC-re. Ez felül fogja írni az aktuálisan kijelzett programot 
a PC-n. Ezért gyõzõdjön meg róla, hogy a program aktuális állapotáról már van 
mentett verziója a PC-n. 
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bereca
Beírt szöveg
A program áttöltése
az S7-200-ba csak
STOP módban lehetséges!

bereca
Beírt szöveg

bereca
Beírt szöveg



Elsõ programozási feladat 
4.4  Az elsõ program mûködése és tesztje 

4.4  Az elsõ program mûködése és tesztje 

Az elsõ példaprogramban S0 kapcsolja
a motort be és ki. S1 kapcsoló a motor
irányát változtatja.
S0 és S1 kapcsolók az elsõ kettõ
kapcsoló a bemeneti szimulátororn. Ezek
a kapcsolók adják a 24V DC feszültséget a
CPU I0.0 és I0.1 bemeneteire. A kimeneti 
szimulátor a Q0.0 és Q0.1 kimenetekre van
csatlakoztatva. Q0.0 kapcsolja ki és be a 
motort. Q0.1 változtatja a forgásirányt.

�� 

A példaprogramban az I0.0 állapota
megegyezik a Q0.0 kimenettel és az
I0.1 állapota megegyezik a Q0.1 állapotával.

$FWLRQV 
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bereca
Beírt szöveg
24 V DC az S7-200 CPU-n az érzékelők számára

bereca
Beírt szöveg

bereca
Beírt szöveg
Oktató szimulátor

bereca
Beírt szöveg
I0.0
Motor
Be/Ki

bereca
Beírt szöveg
I0.1
Irányváltás

bereca
Beírt szöveg
0 V DC az S7-200 CPU-n az érzékelők számára

bereca
Beírt szöveg

bereca
Beírt szöveg
Most próbáljuk ki!
A működtető feszültség csatlakoztatva
van a CPU-hoz. A vezetékezés rendben 
van. Ön megnyitotta a példaporgramot
a CD-ről és letöltötte a CPU-ba.
A CPU RUN állapotban van 
(a zöld RUN LED világít)
Most működtesse az S0 és S1
kapcsolókat és figyelje az eredményt.

bereca
Beírt szöveg

bereca
Beírt szöveg
A LED-ek I0.0-tól I0.7-ig a bemenetek
állapotát mutatják.
A LED-ek Q0.0-tól Q0.5-ig a kimenetek
állapotát mutatják.
I és Q egy nemzetközileg használt 
szimbólum a bemenetekre és 
kimenetekre. (I0.0 Q0.0)

bereca
Beírt szöveg
Bemeneti szimulátor

bereca
Beírt szöveg
Kapcsolók: S0, S1, S2, ...

bereca
Beírt szöveg
Műveletek

bereca
Beírt szöveg
Eredmények

bereca
Beírt szöveg
S0 be

bereca
Beírt szöveg
S0 és S1 be

bereca
Beírt szöveg
I0.0 LED bekapcsol

bereca
Beírt szöveg
I0.0 és I0.1 LED 
bekapcsol

bereca
Beírt szöveg
Q0.0 LED bekapcsol

bereca
Beírt szöveg
Q0.0 és I0.1 LED 
bekapcsol

bereca
Beírt szöveg
Motor forog

bereca
Beírt szöveg
Motor a másik
irányba forog

bereca
Beírt szöveg

bereca
Beírt szöveg



Elsõ programozási feladat 
4.5 A létra diagram (LAD) elemei 
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4.5  A létra diagram (LAD) elemei 
0 és 1 a lehetséges állapotok a digitális vezérléstechnikában. A 0 állapot jelentése a HAMIS 
az 1 állapot jelentése az IGAZ. Ezért mondjuk, hogy a PLC ciklus vagy 0 vagy 1. 

( ) � 

���� 

bereca
Beírt szöveg
Áramköri jelölés

bereca
Beírt szöveg
Jelentés a PLC
technikában

bereca
Beírt szöveg
PLC létra-diagram
jelölés

bereca
Beírt szöveg
Pozitív logika
Bemeneti érzékelő letapogatása

Folyik áram?
Ha igen, akkor a letapogatás 
eredménye IGAZ (1)

bereca
Beírt szöveg
Negatív logika
Bemeneti érzékelő letapogatása

Nem folyik áram?
Ha igen (nincs áram), akkor a 
letapogatás eredménye IGAZ (1)

bereca
Beírt szöveg
Kimeneti Tekercs:

Ha az érték "IGAZ", áram folyik 
a tekercs felé, a tekercs 
működtetve van.
(A tekercs BE van kapcsolva)

bereca
Beírt szöveg
Soros áramköri kapcsolás
(ÉS logika)

Az első ÉS a második kapcsolónak
be kell lennie kapcsolva ahhoz, 
hogy áram folyhasson.

bereca
Beírt szöveg
Párhuzamos áramköri kapcsolás
(VAGY logika)

Az első VAGY a második 
kapcsolónak be kell lennie kapcsolva 
ahhoz, hogy áram folyhasson.

bereca
Beírt szöveg

bereca
Beírt szöveg



Elsõ programozási feladat 
4.6 Az áramköri diagram átalakítása 

4.6  Az áramköri diagram átalakítása 
Hogyan alakítjuk át az áramköri rajzot PLC programmá? Forgassuk el az áramköri rajzot 90°-al 
balra. A tápsín baloldalon fog elhelyezkedni, a föld-sín pedig a jobb oldalon. Középen 
láthatóak a kapcsoló elemei az áramkörnek. A gép áramköri logikáját 
(pl. idõrelék vagy flip-flop-ok) amelyek valamikor vezetékekbõl, kapcsolókból, kontaktorokból, 
segéd és vezérlõ-kontaktorokból álltak, stb., most a PLC vezérli. Érzékelõk, 
bemeneti és választókapcsolók stb. a bemeneti oldalon, mágneskapcsolók 
(motor indító kontaktor, irányváltók, szelepek, stb.) a kimeneti oldalon helyezkednek el. 
Ezek PLC-vel nem helyettesíthetõek. 
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bereca
Beírt szöveg
Áramkör PLC nélkül

bereca
Beírt szöveg
Tápsín

bereca
Beírt szöveg

bereca
Beírt szöveg
Forgásirányváltás:
S1 kapcsolót csatlakoztassa
az I0.1 bemenetre, a K1
mágneskapcsolót a Q0.1
kimenetére a PLC-nek.

bereca
Beírt szöveg

bereca
Beírt szöveg
Motor BE / KI
S0 kapcsolót csatlakoztassa
az I0.0 bemenetre. A mi
példánkban a K0 mágneskapcsoló
helyettesíthető a PLC Q0.0 
kimeneti reléjével.

bereca
Beírt szöveg



Elsõ programozási feladat 
4.7 Az elsõ felhasználói program elemei 

4.7  Az elsõ felhasználói program elemei 
Vessünk egy közelebbi pillantást a PLC program struktúrájára létra diagramban (LAD). 
Ez a fajta megjelenítés nagyon hasonlít az áramköri rajzra. 
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bereca
Beírt szöveg

bereca
Beírt szöveg
1h_pr_en.mwp program létra diagramja

bereca
Beírt szöveg

bereca
Beírt szöveg
Tápsín

bereca
Beírt szöveg

bereca
Beírt szöveg
Ez a hálózati (network) 
kommentár. Használható
a hálózat címeként.

bereca
Beírt szöveg

bereca
Beírt szöveg
Ez a sorszámozott mező 
választja el a hálózatokat. 


bereca
Beírt szöveg
Ez a kontaktus akkor 
aktív, amikor az I0.0 
bementen áram folyik.

bereca
Beírt szöveg
Ez a tekercs / kimenet
akkor aktív, amikor az
előtte lévő kontaktus
(itt I0.1) zárt.

bereca
Beírt szöveg
A hálózatok azért jöttek létre, 
hogy a programot struktúrálják.
Illessze be az aktuális elemeket
a hálózatokba.

bereca
Beírt szöveg

hidasg
Beírt szöveg
I0.1=

hidasg
Beírt szöveg
Q0.1=

hidasg
Beírt szöveg
STL program=            FBD program=

hidasg
Beírt szöveg
I0.1=                      Q0.1=

hidasg
Beírt szöveg
Motor=

hidasg
Beírt szöveg
be/ki

hidasg
Beírt szöveg
Network 1=

hidasg
Beírt szöveg

hidasg
Beírt szöveg

hidasg
Beírt szöveg

hidasg
Beírt szöveg

hidasg
Beírt szöveg
I0.0=

hidasg
Beírt szöveg
Q0.1=

hidasg
Beírt szöveg
(

hidasg
Beírt szöveg
)

hidasg
Beírt szöveg
NETWORK
LD=      I0.0=
            Q0.0=


NETWORK
LD=     I0.1=
           Q0.1=

hidasg
Beírt szöveg
Q0.1=

hidasg
Beírt szöveg
I0.1=

hidasg
Beírt szöveg
Q0.1=

hidasg
Beírt szöveg
I0.1=



Elsõ programozási feladat 
4.8 Állapot megtekintés (online) 

4.8  Állapot megtekintés (online) 

Válassza a menü Debug > Start 
Program Status-t, hogy aktiválja a létra 
diagram állapot nézetét. 
Így most megtekinthetõek a PLC­
operandusok állapota. 

A példaprogramban az S0 kapcsoló az
I0.0 bemenethez van csatlakoztatva.
Ha Ön zárja a kapcsolót és megvizsgálja
a létra-programot állapot nézetben (status view)
azon elemek, amelyeken áram folyik
(IGAZ) kékre színezõdnek.
Az elemek, mûveletek állapotát ciklikusan
olvassa a szoftver a PLC-bõl és frissíti a 
képernyõt.
Ebben az összefüggésben az online azt jelenti,
hogy a PC-vel/programozó eszközzel figyeljük
a PLC-t, hogy lássuk az aktuális állapotokat 
és a ciklikus változásokat. 

,��� 4��� 

,��� 4��� 

A nagyon gyors eseményeket ezen a módon nem tudjuk követni, mert az az idõ, ami az adatátvitelhez 
szükséges (a képernyõre), túl hosszú. Az állapot figyelés "function block diagram" (FBD) nézetben 
szintén lehetséges. 
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Elsõ programozási feladat 
4.9 Utasítások 
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4.9 Utasítások 

,��� 

�,���� 
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bereca
Beírt szöveg
Vezérlő Utasítások

bereca
Beírt szöveg
A vezérlő utasítás a legkisebb egység a PLC felhasználói programban.
Az utasítás két részből áll.

bereca
Beírt szöveg

bereca
Beírt szöveg
Művelet

bereca
Beírt szöveg

bereca
Beírt szöveg
Operandus

bereca
Beírt szöveg

bereca
Beírt szöveg
                        (Mit csinál?)

Az utasítás művelete meghatározza
a funkciót, ami végrehajtódik, amikor
a vezérlő utasítás lefut.

Ebben az esetben a létra diagram (LAD)
eleme az alaphelyzetben nyitott kontaktus,
amely akkor vezet, ha aktív. Ha ez a kapcsoló
sorba kapcsolódik egy másik kapcsolóval, 
akkor a két kapcsoló megvalósítja a 
logikai ÉS műveletet.

Ha ez a kapcsoló párhuzamosan kapcsolódik
egy másik kapcsolóval, akkor a két kapcsoló
megvalósítja a logikai VAGY műveletet.

bereca
Beírt szöveg
                        (... ahhoz hogy)

Az utasítás operandusa (ebben az esetben I0.0)
meghatározza a bemeneteket és kimeneteket
a vezérlő művelet számára. Ez egy operandus 
azonosítóból és egy paraméterből áll.

bereca
Beírt szöveg

bereca
Beírt szöveg
Az operandus azonosító
meghatároz egy területet
a PLC-ben. A fenti példában,
a művelet egy bemeneten 
volt végrehajtva. Más terület
lehet: kimenetek, és 
bit-memória területek.           

bereca
Beírt szöveg
A paraméter az 
operandus címe. 
Egy bájt és egy bit-
címből áll.      

bereca
Beírt szöveg
Operandus azonosító

bereca
Beírt szöveg
Paraméter

bereca
Beírt szöveg

bereca
Beírt szöveg
                      Az operandus struktúrája


Bit cím:			bit szám a bájtban (0..7)
Decimális pont:		különválasztja a bájt címet és a bit számot
Bájt cím:			8bites csoportok száma
Operandus azonosító
(terület azonosító)
Lehetséges területek:		bemenetek, kimenetek
			belső bit memória, speciális memória
			változó memória


bereca
Beírt szöveg





5 Több feladat 

5.1  Az elsõ programmódosítás 

5.1.1  ÉS (AND) logikai mûvelet 

Áramkör PLC nélkül 
A csatlakozók sorba vannak kapcsolva (És logika). A létra diagramban a logika 
a következõ szerint alakul: 

Az áramkör létra diagramja 
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bereca
Beírt szöveg
Feladat: S2 és S0 kapcsolók zárva kell,
hogy legyenek, hogy a motor ventillátor 
elinduljon.
Mint eddig, S1 kapcsoló hatására
a motor ventillátor irányt vált.
A funkció leírása a következő:
A motor megy, ha S0 és S2 zárt.
Ez a létra diagramban a következőt
jelenti: amikor I0.0 és I0.2 zárva van, 
áram folyik a táp vezeték felől
a Q0.0 tekercs felé.

bereca
Beírt szöveg
     

bereca
Beírt szöveg

bereca
Beírt szöveg
ÉS logikai művelet

bereca
Beírt szöveg
 

bereca
Beírt szöveg

bereca
Beírt szöveg
Nincs szükség az S2 kapcsolót vezetékezni, 
mióta az I0.2-re van csatlakoztatva a 
szimulátor. A következő oldalon olvasható,
hogyan választunk, szúrunk be, törlünk
logikai kaput, és hogyan nevezzük el 
az Operandust.

bereca
Beírt szöveg
     

bereca
Beírt szöveg



Több feladat 
5.1 Az elsõ programmódosítás 

5.1.2  Logikai kapu beillesztése 

Ha Ön szeretne további, alaphelyzetben nyitott kontaktust elhelyezni az I0.2-es bemenetre, sorba 
kapcsolva az I0.0 bemenet és a Q0.0 kimenet közé (ÉS mûvelet beszúrása I0.0 és I0.2 közé), 
akkor elõször választani kell egy olyan helyet, ahová elhelyezhetõ az új kontaktus. 

Klikkeljen a következõ elemre, a 
kiválasztott helytõl jobbra. Jelen esetben 
jelölje ki a Q0.0 kimeneti tekercset.
A beszúrás helye a kijelöléstõl balra
található.

Klikkeljen a kontaktus gombra az eszköz sávban (Tool bar), 
majd nyomja meg a megfelelõ funkció gombot. 

Válassza ki a kontaktus típust a legördülõ 
menübõl. Válassza a legfelsõ elemet. 
(alaphelyzetben nyitott kontaktus) 
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hidasg
Beírt szöveg
I0.0=                         Q0.0=

hidasg
Beírt szöveg
I0.0=

hidasg
Beírt szöveg
I0.1=



 Több feladat 
5.1 Az elsõ programmódosítás 

5.1.3  Az operandus bevitele és tesztelése 

Miután beillesztette az új kontaktust, meg kell határozni az operandust. 
Klikkeljen az operandus mezõre, majd vigye be az I0.2 operandust. 
Nyomja meg az Enter billentyût a bevitel megerõsítésére. 

Ne felejtsen el menteni! 

Klikkeljen az egérrel a változtatni kívánt 
mezõre. 

Ha tesztelni szeretné a módosítást:
Töltse le a módosított programot a PLC-be és
tesztelje a programot. Mûködtesse az S0 és
S2 kapcsolókat, hogy elinduljon a motor.
Kapcsolja a programját "ladder status" módba
és figyelje a kapcsoló állapot-változások 
megjelenítését LAD nézetben.
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I0.0 Q0.0

I0.1 Q0.1

1.

2. 3.

4.

5.



Több feladat 
5.1 Az elsõ programmódosítás 

5.1.4 Kontaktus vagy operandus törlése 

Ha Ön törölni akarja az I0.2 kontaktust, jelölje ki az egérrel és nyomja meg a DEL 
billentyût. 
Ebben az esetben újra össze kell kötni I0.0-át és  Q0.0-át. 
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,��� 4��� 

,��� 

,��� 

,��� 

4��� 

4��� 

4��� 

,��� 4��� 

Ha kijelölést, sort, oszlopot, hálózato(ka)t vagy
alprogramot szeretne törölni, kövesse
az alábbiakat:

Jelölje ki a kívánt elemet.
Nyissa meg a Törlés menüt: Edit > Delete.
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Több feladat 
5.2 A program második módosítása 

5.2  A program második módosítása 

5.2.1  VAGY (OR) logikai mûvelet 

Feladat: 
S0 és S2 kapcsolók mûködtetve vannak, 
ami hatására a motor mûködik. S3 kapcsoló
alternatívaként önállóan el tudja indítani
a motort. S1 kapcsoló hatására a motor
forgásirányt vált.
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PLC nélküli áramkör 

A funkció leírása lent látható: 
Amikor (S0 ÉS S2) VAGY S3 mûködtetve van, a motor elindul. Létradiagramban:
amikor I0.0 ÉS I0.2 VAGY I0.3 kontaktusok zártak, áram folyik a tápvezetéktõl a Q0.0
kimeneti tekercsig. Ez egy párhuzamos kapcsolás S0 és S2 felõl S3 irányába (VAGY logikai mûvelet).
A mi programunkban ez a logika a következõképpen néz ki:

Nem szükséges S3 kapcsolót vezetékezni, 
mert I0.3-ra csatlakozik a szimulátoron 
keresztül. A következõ oldalon megtalálható 
hogyan válasszunk ki, majd szúrjunk be egy 
VAGY logikai kaput az áramkörbe. 4��� ,��� 
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bereca
Beírt szöveg
VAGY logikai művelet

bereca
Beírt szöveg

bereca
Beírt szöveg
Az áramkör létra-diagramja

bereca
Beírt szöveg



Több feladat 
5.2  VAGY logikai kapu beillesztése 

5.2.2  VAGY logikai kapu beillesztése 

Használja az egeret, hogy kiválasszon 
egy szabad pozíciót ugyanabban a 
hálózatban, és szúrjon be egy 
alaphelyzetben nyitott kontaktust a területre. 

Klikkeljen az egérrel a felfelé mutató nyíl 
gombra az LAD eszközsávban. 

Most a párhuzamos VAGY ág 
elkészült.
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I0.0

I0.0

I0.0

Q0.0

I0.2 Q0.0

I0.3

I0.3

I0.2 Q0.0

I0.1 Q0.1



Több feladat 
5.3 A program harmadik módosítása 

5.3  A program harmadik módosítása 

5.3.1  Bekapcsolás-késleltetõ (On-delay) idõzítõ 

Feladat: 
A következõ program-módosítás során
beszúrunk egy bekapcsolás-késleltetõ
idõzítõt az 1. gyakorló programba.
Amikor az I0.3 (S3) aktiválva van a 
szimulátoron, a bekapcsolás-késleltetés
elindul. A Q0.0 kimenet, és így a motor
a késleltetés végéig nem aktiválódik.
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PLC nélküli áramkör 

A hozzáadot idõzítõ funkció nem igényel 
vezetékezési munkát a PLC-n. 
Minden szükséges kapcsoló és beavatkozó 
már vezetékezve van. Az idõrelé 
PLC idõzítõ funkcióval helyettesíthetõ. ,��� 
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 Az áramkör létra-diagramja 
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bereca
Beírt szöveg
A következő oldalon bemutatjuk 
az S7-200 PLC bekapcsolás-késleltető 
időzítő funkcióját. Fogunk csinálni 
egy időzítő hálózatot, és az itt látható 
három hálózatos programot.

bereca
Beírt szöveg

bereca
Beírt szöveg



Több feladat 
5.3 A program harmadik módosítása 

5.3.2  A bekapcsolás-késleltetõ idõzítõ funkció megértése 
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bereca
Beírt szöveg
Önnek szüksége van egy 1s-os 
bekapcsolás késleltetésre. Az 
S7-200 CPU-k 256db időzítővel
rendelkeznek. Az időzítők T0 -
T255-ig vannak jelölve. Használja
a T34-et ebben a példában.

bereca
Beírt szöveg
Ahhoz, hogy az időzítő
fusson, el kell indítani.
A mi példánkban ezt
az I0.3 bemenettel
tesszük meg az "IN"
funkció-bemeneten.

bereca
Beírt szöveg
Állítsa az időzítés értékét 1s-ra, a PT értékének
100-ra állításával. Az időzítés értéke kiszámítható
a PT faktor (itt 100) és az időalap szorzatából.
(T34 időalapja 10ms, 100 x 10ms = 1s)

bereca
Beírt szöveg
Időalap

bereca
Beírt szöveg
A CPU 222-nél 1ms-os, 
10ms-os és 100ms-os 
időalappal állnak 
rendelkezésre az időzítők.
Az időzítőket csak 1-szer 
használhatjuk.

bereca
Beírt szöveg
Az S7-200-ban minden időzítőnek van
egy állapot bitje (idő eltelt=/nem telt el)
Ez a bit az időzítő bit.
A T34 időzítőnél ezt a bitet T34-nek  
hívjuk.
Az I0.3 bemenet értéke "1" kell, hogy legyen
1s időtartamig, mielőtt az időzítő bit T34
"1" lesz. Ha a késleltetés még nem telt el, 
amikor az engedélyező jel "IN" törlődik, 
az időzítő "0"-ba áll és az időzítő bit 
nem íródik be (nézd az idő-diagramot
alul). Az időzítő bit használható, mint
kontaktus operandus.

bereca
Beírt szöveg
"IN" pl.: I0.3

bereca
Beírt szöveg

bereca
Beírt szöveg
T34 időzítő bitje

bereca
Beírt szöveg
Idődiagram 50ms-os időre

bereca
Beírt szöveg
Txx pl.: T34
10s-os időalappal

bereca
Beírt szöveg

bereca
Beírt szöveg

bereca
Beírt szöveg

bereca
Beírt szöveg
A CPU 222-nél 1ms-os, 
10ms-os és 100ms-os 
időalappal állnak 
rendelkezésre az időzítők.
Az időzítőket csak 1-szer 
használhatjuk.



Több feladat 
5.3 A program harmadik módosítása 

5.3.3  A bekapcsolás-késleltetõ idõzítõ programozása 
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bereca
Beírt szöveg
Az eszközsáv (Toolbar) használata

bereca
Beírt szöveg

bereca
Beírt szöveg

bereca
Beírt szöveg
Ahhoz, hogy lássuk a hatását a 
beillesztett időzítő kontaktusnak a 
VAGY logikai hálózatunkban, 
készítenünk kell egy időzítő
blokkot az előző hálózatban. Jelöljük
ki az első hálózat egy részét a 
jobb egérgombbal.

bereca
Beírt szöveg
Illesszünk be egy alaphelyzetben nyitott
kontaktust az I0.3 részére az új hálózat
első oszlopába. 

bereca
Beírt szöveg
Azután tegyünk egy bekapcsolás-késleltető
típusú időzítő blokkot a második oszopba.
Válasszuk ki a "Box-F9" eszköz gombot.
Görgessünk lefelé a TON (bekapcsolás
késleltető időzítő)-ig

bereca
Beírt szöveg
Válasszuk ki a "PT" bemeneti mezőt, és 
adjuk be az értéket. (Ebben az esetben
100 és T34.)

bereca
Beírt szöveg
Az utolsó lépésben a T34 időzítő bitet
kell elhelyeznünk a 2. hálózatban az 
I0.3 helyén. Végezze el a változtatásokat..

bereca
Beírt szöveg
Mentse el a programot és
töltse bele a PLC-be

bereca
Beírt szöveg

bereca
Beírt szöveg



Több feladat 
5.4 Munka projektekkel 

5.4  Munka projektekkel 

5.4.1  Programozás szimbólumokkal 
Eddig a PLC programban operandusokkal (PLC nyelven) dolgoztunk, úgy mint I0.3 vagy 
T34, de ha a program hosszabb, nem könnyû összepárosítani ezeket az operandusokat 
az aktuális funkciókkal a vezérlõrendszeren belül. Egyszerûbb lenne a program értelmezése (olvasása), 
ha át tudnánk váltani az operandus neveket "beszédesebb" szövegre. Ez pontosan megegyezik azzal, amit a 
szimbólumokkal történõ programozás kínál. 
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bereca
Beírt szöveg
A szimbólikus címzéshez ki kell tölteni a szimbólum
táblát (symbol table). Válassza a szimbólum táblát
(symbot table) a navigációs sávban vagy válassza:
View -> Component -> Symbol table.

bereca
Beírt szöveg
Itt látható a szerkeszthető szimbólum tábla (symbol table). Vigye be azt a nevet, amit szeretne
látni eredeti szövegként a "Symbol" mező alá. Az "Address" mező alá vigye be az operandust, 
amit össze szeretne rendelni a szimbólikus névvel. A "Comment" mező alá megjegyzésként
bármilyen szöveg bevihető, ami később még segítség lehet. Ne felejtse el elmeneteni a 
munkát.

bereca
Beírt szöveg
Következő oldalon folytatódik

bereca
Beírt szöveg
  

bereca
Beírt szöveg



Több feladat 
5.4 Munka projektekkel 

Simbólum használata a hálózatban 
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bereca
Beírt szöveg

bereca
Beírt szöveg
Válassza a menü eszköz View -> Symbolic Addressing
menüpontot, hogy kijelzési módot váltson. Ha a 
szimbólum információs táblázat is ellenőrizve van, 
akkor minden hálózat alján láthatóak a szimbólumok
összegzései.

bereca
Beírt szöveg
Ha a szimbólikus címzést választotta, és
programozási módot vált (LAD, STL, FDB),
a szimbólikus címzés meg fog jelenni.
A szimbólikus címzést be és ki lehet 
kapcsolni.

bereca
Beírt szöveg
A fenti ábrán egy felhasználói program, létra diagram nézetben, szimbólikus címzéssel látható.
Ön szintén programozhat szimbólikus címzéssel. Ha ön szeretné bevinni például az "S3"-at, akkor
önnek csak meg kell bizonyosodni arról, hogy ez az operandus már benne van a szimbólum táblában.

bereca
Beírt szöveg



Több feladat 
5.4 Munka projektekkel 

5.4.2  Új projekt létrehozása 
Ha ön szeretne írni egy saját programot, akkor szüksége van egy bizonyos helyre, amiben 
a program-fájlt tárolja. A STEP 7-Micro/WIN esetében, ez a tároló a projekt. Egy S7-200 project 
tartalmazza az összes kiegészítõ információt a programról, például a szimbólum táblát,  
megjegyzéseket, stb. 
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bereca
Beírt szöveg

bereca
Beírt szöveg
Készítsünk egy új projektet a menü paranccsal
File -> New

bereca
Beírt szöveg
Az eredmény egy projekt a következő névvel: Project1.
Ön elkezdheti a programozást.

bereca
Beírt szöveg
Nézze meg a következő
oldalt!

bereca
Beírt szöveg

bereca
Beírt szöveg



Több feladat 
5.4 Munka projektekkel 

A projekt mentése más néven 
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bereca
Beírt szöveg
Mentse el a Projekt1-et más néven, 
ami a programra utal, közvetlenül
programozás után, vagy közben.

bereca
Beírt szöveg
Ebben az ablakban, adjon egy 
nevet a projektnek, és válasszon
egy helyet / elérési utat, ahol 
tárolni szeretné.

A végén mentse el a munkáját!

bereca
Beírt szöveg

bereca
Beírt szöveg
Ezen lépések alatt, ön létrehozott egy új projektet
és egy új program fájlt. Ön most már írhat egy
új programot.

bereca
Beírt szöveg



Több feladat 
5.4 Munka Projektekkel 
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bereca
Beírt szöveg

bereca
Beírt szöveg
Gratulálunk, Ön most már használhatja
a SIMATIC S7-200 PLC-t, az
automatizálási projekteknél.
Ha szeretne többet tanulni, hasznos
információkat fog találni a 
függelékben.

bereca
Beírt szöveg



 Több feladat 
5.5 Szeretne többet tanulni? 
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5.5  Szeretne többet tanulni? 
Több példaprogram található a "Samples" könyvtárban a STEP 7-Micro/WIN alatt. 

Az "Egy Órás Tanfolyam" példái folytatódnak a "Két Órás Tanfolyam" programjaival. 

Megjelent az S7-200 "Tippek & Trükkök" CD ROM. A "Két Órás Tanfolyam" és a
"Tippek & Trükkök" CD elérhetõ az Ön SIMATIC képviselõjénél. 

További információkat talál az S7-200 kézikönyvben. (www.siemens.hu/ad) 

Ha S7-200 oktatásra van szüksége, érdeklõdjön a SIMATIC képviselõjénél. 

Kérem, lépjen kapcsolatba azzal a SIMATIC forgalmazóval, ahol a Starter Kit-et vásárolta. 
Ha nem sikerül kapcsolatba lépnie a SIMATIC forgalmazóval, kérem hívja a Siemens Mûszaki 
Támogatást: 

Mûszaki támogatás (Technical Support): 

Magyarországon (Budapest): 36 (1) 471-1715 
Világszerte (Nürnberg): 49 (180) 5050-222 

bereca
Beírt szöveg
Megválaszolatlan kérdés?
Műszaki probléma?
A SIMATIC képviselő örömmel
segít.

bereca
Beírt szöveg





FFüggelék 

F.1  Bitek, bájtok és szavak ... 
Az információ legkisebb egyége a digitális technikában a "bit". A bit állapota
"0" (hamis vagy nem igaz) vagy "1" (igaz). 

A világítás kapcsolónak például szintén csak két állapota van, "világít" vagy "nem világít". A kapcsoló
állapota válasz a kérdésre "Be van kapcsolva a lámpa?" vagy igaz (be van kapcsolva a lámpa) vagy
hamis (a lámpa nincs bekapcsolva). A világítás kapcsoló így információval bír egy bit segítségével. 
Azt az állapotot, amikor a "kapcsoló bekapcsolva, de az izzó kiégett" szándékosan kihagytuk a példából. 
A PLC-ben, a bitek csoportokba vannak szervezve. A 8 bites csoportot bájtnak hívjuk. Minden bit
a csoporton belül pontosan meghatározott helyen van, saját címmel ellátva. Minden bitnek van egy bájt
címe és egy bit címe 0-tól 7-ig. A 2 bájtos csoportot szónak hívjuk. A 4 bájtos csoportot 
dupla szónak hívjuk. 
A számok ebben a logikai rendszerben bináris számok és a számítások a kettes számrendszeren 
alapulnak.

A szó a PLC-ben jelenthet integer (egész) számot  -32768 -tõl +32767 -ig. Egy bit 
215- értékkel (legmagasabb helyiérték) a negatív elõjelzésre szolgál (amikor az az érték "1" 
a szám negatív). 
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20=

(27+26+25+24+23+22+21+20=255
20=1,21=2,22=4,23=8,24=16,25=32,26=64,27=128)

bereca
Beírt szöveg
Ha ez a bit pozíció "0" (= hamis vagy nem igaz) akkor az érték 0 mert
0 * 2   = 0 (tartalom * bit pozíció értéke).
Ha ez a bit pozíció "1" (= igaz) akkor az érték 1 mert 1 * 2   = 1

bereca
Beírt szöveg

bereca
Beírt szöveg
0

bereca
Beírt szöveg
0

bereca
Beírt szöveg
Ez a helye a 2    -nak a bájtban!

bereca
Beírt szöveg
0

bereca
Beírt szöveg

bereca
Beírt szöveg
1 bit =

bereca
Beírt szöveg

bereca
Beírt szöveg

bereca
Beírt szöveg
1 bájt =

bereca
Beírt szöveg
1 szó =

bereca
Beírt szöveg
2   2   2   2   2   2   2   2

bereca
Beírt szöveg

bereca
Beírt szöveg
7        6         5         4         3         2         1         0

bereca
Beírt szöveg
2   2   2   2   2   2   2   2  2   2   2   2   2   2   2   2

bereca
Beírt szöveg
 15       14       13       12       11      10       9         8       7         6         5         4         3         2         1         0

bereca
Beírt szöveg
Ez a helye a bájtnak a szóban, 255 maximum értékkel.

bereca
Beírt szöveg
Minden bit pozíciónak a bájton belül lehet az értéke "1"
vagy "0". A biteket lehet egyenként (pl.: kapcsolók) vagy
csoportokban (pl.: számok kifejezésére) 0 és 255 között.

bereca
Beírt szöveg

    


bereca
Beírt szöveg
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F.2  Az S7-200 cím-területei 

A lenti diagram mutatja az S7-200 PLC memória címzését, ahol a bemenetek és kimenetek 
vannak leképezve. Például ha feszültség jelenik meg a fizikai bemeneten, "1" jel 
képzõdik le egy memória-címen, ami hozzá van rendelve ehhez a bemenethez. Azok a 
memóriaterületek, amelyek a PLC fizikai be/kimenetekhez vannak hozzárendelve, 
"process image" területnek hívjuk. PII a bemeneteknél, PIO a kimeneteknél. Ez a memória 
terület tartalmaz egy képet (image) a vezérlõ folyamat jeleirõl. 

7  6  5  4  3  2  1  0

7  6  5  4  3  2  1  0

I0.=
I1.=
I2.=
I3.=
I4.=
I5.=

.   .
I15.= 

Q0.=
Q1.=
Q2.=
Q3.=
Q4.=
Q5.=

Q15.=

.. 

bereca
Beírt szöveg
Az S7-200 PLC CPU 222 címterületei

bereca
Beírt szöveg

bereca
Beírt szöveg
Bemenetek:

bereca
Beírt szöveg
Kimenetek:

bereca
Beírt szöveg
Bájt címek

bereca
Beírt szöveg
Bit címek (megfelel a bit érték
kitevőjének)

bereca
Beírt szöveg
Alaplapi bemenetek (I0.0 - I0.7)

bereca
Beírt szöveg
Bővítő modulok címterületei

bereca
Beírt szöveg

bereca
Beírt szöveg
Szabad terület a PII területen.

bereca
Beírt szöveg
Bit címek (megfelel a bit érték
kitevőjének)

bereca
Beírt szöveg
Alaplapi kimenetek (I0.0 - I0.7)

bereca
Beírt szöveg
Bővítő modulok címterületei

bereca
Beírt szöveg
Szabad terület a PIO területen.

bereca
Beírt szöveg
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F.3  Az S7-200 PLC ciklikus program végrehajtása 
Az összes SIMATIC PLC ciklikusan mûködik. A ciklusok folyamán a külsõ kapcsolók állapotait 
elõször beolvassa a bemenetekrõl, ami a "Process Image" bemeneti táblában tárolódik. A vezérlõ 
program végrehajtódik a "process image" értékei alapján.  A kimenetek a "Process Image" kimeneti 
táblában ciklikusan frissítõdnek a vezérlõ létra diagram logikája alapján. 
Az utolsó lépésben az új kimeneti értékek a "Process Image" táblából átkerülnek a fizikai 
kimenetekre. Ez a végrehajtó ciklus ismétlõdik végtelen számban FUTÁS (RUN) módban. 
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bereca
Beírt szöveg
A ciklus kezdete

bereca
Beírt szöveg

bereca
Beírt szöveg
"Process Image" bemeneti tábla

bereca
Beírt szöveg
S7-200 program ciklus
végrehajtja és hivatkozik:
- Bit memóriák
- Időzítők
- Számlálók
- ...

bereca
Beírt szöveg
"Process Image" kimeneti tábla

bereca
Beírt szöveg
A ciklus vége

bereca
Beírt szöveg
Bemenetek

bereca
Beírt szöveg
Kimenetek

bereca
Beírt szöveg
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